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Due Now command

This command when selected will display the next bill which is due and make it the selected 
bill.



Documentation for BillManager

Bruce L. Brown Jr.
AnyWare Consulting

This is the documentation for the Bill Managing software.    Please select one of the following 
sub-topics for additional information:

Overview of the software
Additional Software
Help Strategy
Revision History

Dedications:
Corinne, who thought I'd invented the software equivalent of a Tinker Toy.
Ron, who volunteered to be 'one of the first'.
David, who was right in line behind Ron.

In addition to the prescribed methods of contacting me, I may be contacted through a 
Bulletin Board known as Companion and Friends 1-714-521-9598, my account number 
there is 282.



Overview of Bill Manager software

BillManager is a software product which keeps track of all of your regular bills in a cardfile 
type fashion.    You may select a bill to pay, or have the software prompt you when a bill is 
due.    It will cause the updating of the Checkbook and print the check using the CheckPrint 
products.    The BillManager software makes extensive use of DDE (Dynamic Data Exchange) 
to obtain information regarding the check from cooperating software.    A brief description of 
this software is described under the heading of Additional Software.



Additional Software

The BilManager program represents only a piece of a much larger software product.    
Additional programs are available which intercommunicate with the BillManager program.    
For additional information select one of the following:

CheckBook
CheckWrite
CheckPrint
Disburse



Help Strategy

Throughout the checkbook program every attempt has been made to document each and 
every field which the user can either view or modify.    Often times, this appears to be 
overkill, but it is done in keeping with the general design concept of the help system.

 Contextual Help is available from anywhere within the program.    By pressing 
SHIFT+F1 or by selecting the Help Contextcommand Contextual Help mode is enabled.    A 
context Cursor is displayed to indicate that you are in Context Help mode, additionally, the 
Caption Bar is changed to reflect this information.    While in Context Help you may position 
the cursor on any field and click the left button for detailed information regarding that field.   
You may also click on the Caption Bar for general information about the specific window that 
the Caption is for.



Revision History

Version 1.0 Initial Release, March 19, 1991
Version 2.0 Released April 4, 1991
Version 2.1 Released April 12, 1991
Version 2.2 Released April 19, 1991
Version 3.0 Beta Release for Disburse May 8, 1991
Version 3.1 Released June 5, 1991



Checkbook

The Checkbook software assists in the management of a checking account.    It allows you to 
enter Credits and Debits, and to get an updated running Balance as well as a monthly 
Statement Balance.    This program works in conjunction with the CheckWrite and 
BillManager.



CheckPrint

The CheckPrint software allows the user to print checks on a variety of printers.    Currently, I 
am using an Hewlett Packard LaserJet IIP to print my checks on.    this software works in 
conjunction with the BillManager and CheckWrite software.



CheckWrite

The CheckWrite software allows the user to write 'hand checks' updating the Checkbook and 
printing the check using CheckPrint.    Hand checks are any checks which are not generated 
by the BillManager.



Disburse

The Disburse program allows you to disburse a single payment into several different 
catagories.    This would, for instance, allow you to catagorize a credit card bill based upon 
the types of purchases.

Note
Currently, Disburse allows you to only disburse debits, either from the Checkbook, 
BillManager, or CheckWrite software.    In later version it will allow for the disbursal of credits.



Version 1.0, March 19, 1991

This is the first release of the software.    Although extensively tested, it is the first release.    
I've been using it for about 2 months without any problem, so it is basically stable.    While I 
do anticipate revisions to the software, it appears to be complete.    If you have any 
suggestions for changes, enhancements, or if you find any problems you may contact me at 
the address or phone number specified in the Software 
RegistrationHELPID_DIALOG_REGISTER form.



Version 2.0, April 4, 1991

I've changed the DDE interface a bit.    Now, if/when the checkbook or checkprint 
program goes away, you are notified.

The background color now conforms to the windows background application color 
setting.

The DueNow feature now works.    Additionally, all of the past due bills have a RED 
index.

The Bills are now sorted alphabetically.    Pressing any alpha-numeric key will position 
you to the next bill with the same first letter in its index as the key you pressed.

Cut/Copy/Paste are implemented and working.



Version 2.1, April 12, 1991

I've tightened up the program security a bit.    Maybe this will make it less prone to 
being crock'd.

I've Changed the ICONs such that they reflect if there are any past due bills.    If there 
are the ICON will be RED, otherwise it is the old, yellow thing.



Version 2.2, April 19, 1991

I've corrected a visual problem with the ICON.

Opps...    Seems that if you click on the arrows when there aren't any bills things go 
wrong.    Well, this should fix it.

I've changed the DLL that manages all of the File Dialogs.    It now provides some 
information about the type of file being manipulated in the Caption.

There was a problem in the initial display of bills, whereby a bill would end up in the 
window above the bills.    This has now been corrected so that it doesn't occur.



Version 3.0 (Beta), May 8, 1991

I've added code to support DISBURSE, the bill disbursal program.    Complete docs 
are forthcomming.



Version 3.1 , June 5, 1991

HELP Documentation for the interface to Disburse has been added.
The "Pay for it" annoyance box was a bit too annoying!!!    Now, it only comes up 

when you are at the top-level.    This means you can save files, and register the software 
without being hit by this beast.



Menu:File

The File menu includes commands that enable you to open and save bill files, establish a 
new bill file, print a check.    Additionally, to register the software.

For more information, select the File menu command name.

New
Open
Save
SaveAs
Print Check
Registration
Exit



File New Command

Initializes a new bill file.    If there are changes to the current bill file the Save Current 
Changes message will be invoked.



File Open Command

Opens an existing bill file.    If there are changes to the current bill file the Save Current 
Changes message will be invoked.    A file open dialog box is presented to the user to assist 
in the selection of the file.



File Save Command

Saves the current bill file back into the file that it came from, overwriting the previous 
contents.



File SaveAs Command

Presents the user with a SaveAs file dialog box allowing for the specification of the file that 
the bill file is to be saved into.



File Register Command

Activates the Software Registration dialog box.    By completing this dialog and mailing it, 
along with the registration fee you are provided a registered copy of this application.



File Print Check Command



File Exit Command

Exits the BillManager application.    If there are changes to the current bill file the Save 
Current Changes message will be invoked.



Menu:Edit

The edit menu allows you to create, modify and delete bills.
For more information, select the Edit menu command name.

Modify
Add
Remove
Cut
Copy
Paste
Check Info



Edit Modify Command

Allows you to modify the currently selected Bill.    This presents a Bill dialog box.



Edit Add Command

Allows you to create a new Bill.    This presents a Bill dialog box.



Edit Remove Command

This command allows you to delete the currently selected bill.



Edit Cut Command

This command deletes the currently selected bill, saving the information in the clipboard.



Edit Copy Command

This command copies the currently selected bill into the clipboard.



Edit Paste Command

This command creates a new bill from the information saved in the clipboard.



Edit Check Info Command

this command allows you to modify the amount and checknumber of the selected bill.    It 
persents an Check Information dialog box.



Options menu

The optiosn menu allows you to select which options are to be enabled or disabled.    For 
further information select one of the following:

Update Checkbook
Print Check
Disburse



Update Checkbook

When this option is enabled the checkbook register will be updated to reflect any checks 
that were either written or voided.    This requires the Checkbook software to be running.



Print Check

When this option is enabled the checks are printed when they are written.    This requires the
CheckPrint software to be running.



 



Options Disburse Command

This enables the ability to disburse checks to the Disburse program.    When enabled, each 
bill that is paid is also sent to the Disburse program.



Menu: Help

The Help menu includes commands that enable you to obtain help regarding various 
features of the checkbook.

For more information, select the Help menu command name.

Context
Overview
Keyboard
Index
Using Checkbook
About



Help:Context Toggle

Selecting this item has the effect of toggling contextual help on and off.    When Contextual 
help is on the Context Help Cursor is displayed.    When it is off the normal cursor for the field
is displayed.    By positioning the cursor and clicking the left mouse button you can receive 
detailed information regarding the particular item.



Help:Overview Command

Presents an overview of the CheckWrite program.



Help:Index Command

Presents a Help index for the CheckWrite program.



Help:Keyboard Command

Provides a description of the keys available at a given point.

Keyboard commands



Help:Using Help Command

Provides the user with information on how to use the help system.



Help:About Command

Displays the About dialog box.



Dialog:About

This dialog box presents general information to the user regarding the software being run.    
For further information select one of the following commands:

Actions:
OK



Action:OK

Select this action button once you have reviewed the About dialog box to remove it and 
return to the application.



Bill information

The Bill information dialog box allows you to modify the selected Bill.    For more information 
select one of the following fields:

Selections:
Frequency
Weekly
Monthly

Edits:
Specific
Index
Payee
Memo
Control

Action:
OK
Cancel



Frequency

This combobox allws you to select how frequently the bill is to be paid.    The available 
choices are: Weekly, Monthly, and Specific.



Weekly

When the frequency is weekly, this combobox will contain the various days of the week.    
Select the one that is appropriate for the bill you have selected.



Monthly

When the frequency is monthly, this combobox will contain the various days of the month.    
Select the one that is appropriate for the bill you have selected.



Specific

When the frequency is specific, this editbox will allow you to specify the date on which the 
bill is due.    Select the one that is appropriate for the bill you have selected.    The format for 
the date is MM/DD/YY. an example, 3/19/91 for March 19, 1991.



Index

This is the text that will be displayed on the index line of the bill.    Since the bills are 
presented in a cardfile fashion, only the index line of the bills may be seen onnon-selected 
bills.



Payee

This is whom the bill is to be paid to.    This field is copied into the "pay to the order" field on 
the check when it is printed and the "description" field of the checkbook.



Memo

This is the memo, in which I usually put the account number of the bill.    This field is copied 
into the "memo" field on the check when it is printed and the "memo" field of the 
checkbook.



Control

This is a control that can be used for programs which make use of Control fields.    This field 
is copied into the checkbook "control" field and can be output by the checkbook program for 
use in tax preparation programs.



Action: OK

Select this action after you have reviewed your modifications and are satisfied with them.



Action: Cancel

Select this action after you have reviewed your modifications and are not satisfied with 
them.    This will cause them to be discarded.



Check information

The check information dialog box allows you to modify the check information for the 
selected Bill.    For more information select one of the following fields:

Edit:
Amount of Bill
Next check number
Selected Bill's check number

Information:
Last check number
Current Balance

Action:
OK
Cancel



Amount of Bill

This is the amount that the check will be written for when the bill is paid.



Next check number

This is the check number that will be assigned when the next bill is paid.



Selected Bill's check number

This is the check number that was assigned the last time that this bill was paid.



Last check number

This is the last check number that was assigned in the checkbook register.    the checkbook 
software must be running for this value to be valid.



Current Balance

This is the current balance of the checkbook.    The Checkbook software must be running for 
this value to be valid.



Action: OK

Select this action after you have reviewed your modifications and are satisfied with them.



Action: Cancel

Select this action after you have reviewed your modifications and are not satisfied with 
them.    This will cause them to be discarded.



Bill index card

All of the information relevant to a bill is presented on the Bill Index Card.    This information 
can be modified via the Edit Modify or Edit Check Information command.



Keyboard

The following keys are available:

Key Function

Enter Edit Modify
Insert Edit Add
Delete Edit Remove
Shift+Del Edit Cut
Ctrl+Ins Edit Copy
Shift+Ins Edit Paste
Tab Edit CheckInfo
Spacebar File PrintCheck
Shift+F1 Help Context
Left Arrow Flip forward to the next bill
Right Arrow Flip backward to the next bill
AlphaNumberic Positions to the next card whose index matches the key pressed



Scroll buttons

You may click on either of the scroll buttons to select a different bill.    Clicking the left moves
forward, the right backward.



This is the date field, the Month and Day will be placed here.



This is the year field, the Year will be placed here.



This is the payee field, this is where the Pay to the Order goes.



This is the printed amount of the check.    An example is 15.23



This is the written amount of the check. An example is Fifteen and 23 cents



This is where the memo is written on the check.



 This is the cursor that is displayed when context sensitve help is enabled.



Dialog:Software Registration Form

Completing this form and mailing it to the directed address, along with the amount of money
specified allows you continuing use of this software package.

For more details select one of the following fields:

Package Name
Package Price
Mail From

Name
Address
City
State
Zip
Phone

Media
3 1/2 Disk
5 1/4 Disk

Add to Mailing List
Obtained From

BBS
Friend
Vendor
Show
Name
Phone

Action
Print



Text:Package

This is the name of the software package that you are registering for.



Text:Price

This is the price of the software package.    In U.S. Dollars, this may be either in the form of a 
check or money order made payable to the name contained in the 'Mail To' box.



Edit:Name

This is your name, or the name of the company who wishes to register the software.



Edit:Address

This is your address or the address of your company.



+Edit:City

This is the city in which you or your company is located.



Edit:State

This is the state in which you or your company is located.    This is also where the Country is 
specified for non-US states.



Edit:Zip

This is your ZIP code (Zoning Improvement Plan - for those trivia buffs).



Edit:Phone

This is your phone number, including area code and country code if you are outside the 
United States.



Button:3 1/2 Disk

This button is used to indicate that you want software shipped on 3 1/2 inch disks.



Button:5 1/4 Disk

This button is used to indicate that you want software shipped on 5 1/4 inch disks.



Toggle:Add to Mailing List

Check this box if you want to be added to the mailing list.    This is how you find out about 
new versions of software as well as other additional products.



Button:BBS

This button is used to indicate that you obtained this software from a BBS (Bulletin Board 
System).    Although not required for registration, this information will be helpful in 
completing this form.



Button:Friend

This button is used to indicate that you obtained this software from a friend.    Although not 
required for registration, this information will be helpful in completing this form.



Button:Vendor

This button is used to indicate that you obtained this software from a vendor.    Although not 
required for registration, this information will be helpful in completing this form.



Button:Show
This button is used to indicate that you obtained this software from a show.    Although not 
required for registration, this information will be helpful in completing this form.



Edit:Name

This is the name of the BBS, Friend, Vendor, or Show that you obtained this software from.    
Although not required for registration, this information will be helpful in completing this 
form.



Edit:Phone

This is the phone number of the BBS, Friend, Vendor, or Show that you obtained your 
software from.    Although not required for registration, this information will be helpful in 
completing this form.



Action:Print

This action button is selected after you have completed the registration form.    It will print 
the form on your printer.    If you don't have a printer, then write the information on paper 
and send it along with your remittance.



Message: Replace existing filename

This message is issued when, as the result of a file saveas command, you would overwrite 
an existing file.

Actions:
YES Causes the file to be overwritten, completing the file saveas command.

NO Causes the file saveas command to be aborted without overwriting the existing 
file.



Message: Save Current Changes filename

This message is issued when, as the result of a File New, or File Exit command, or any other 
command that replaces file data, would potentially cause you to lose your modifications.

Actions:
YES Causes the file data to be saved, and then completes the requested 

command.

NO Causes the file data to NOT be saved, and then completes the requested 
command.

CANCEL Causes the    requested command to be aborted leaving the file data intact.



Dialog: File Open

The File Open dialog box provides the user with a means of specifying the file to be read.    
For additional information, select one of the following:

Objects:
FileName
FilePath
FileList

Actions:
Open
CANCEL



Edit: File Name

This is the name of the file to be opened.    It is appended to the File Path to form a full file 
specification.



Text: File Path

This is the path to the file being specified.    It is prepended to the File Name to form a full file
specification.



Listbox: File List

This listbox contains all of the files and directories which can be selected as the File Name 
and File Path.



Action: Open

Opens the specified file for input into the program, replacing or augmenting the existing file 
data.



Action: Cancel

Cancels the file opening, and returns with the file data still intact.



Dialog: File SaveAs

The File SaveAs dialog box provides the user with a means of specifying the filename    that 
the file data is to be saved under.    For additional information, select one of the following:

Objects:
FileName
FilePath

Actions:
Save
CANCEL



Edit: File Name

This is the filename the file data is to be saved into.    It is appended to the File Path to form a
full file specification.



Text: File Path

This is the path to the file being specified.    It is prepended to the File Name to form a full file
specification.



Action: Save

Saves the file data into the specified file.



Action: Cancel

Cancels the file SaveAs, and returns with the file data still intact.




